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What’s New in DataCAD X3?
Persistent Layer Manager
The Layer Manager can now remain open while you are working in DataCAD. When you
turn layers on and off, the result is shown immediately in the drawing.

The persistent Layer Manager is particularly beneficial if you are using a multi-screen
configuration or a wide-screen monitor. You can position the Layer Manager on the second
monitor or off to the side of the screen, and continue working on your drawing while it is
open. As you highlight layers in the Layer Manager, you can see the current Z-Base and
Height of the layer, how many entities are present, and what material is assigned for
rendering. You also have the ability to adjust which layers are included in your GoTo
Views via the [Update] button in the GoTo Views section.
Changing the order of layers by clicking and dragging them to a new position in the list, or
by using the “Move Up” or “Move Down” buttons, the new order is saved immediately.
The “Save new layer order” button remains grayed out. If you click on the “On,” “Lock,”
“Color,” “Name” or Count” column headers to change the order, the “Save new layer
order” button becomes active. If you wish to save the new order, you must click this button.

To enable this feature, open the Layer Manager in a drawing and click the check box which
says “Keep Layer Manager Open.” You will need to exit and reopen DataCAD in order for
this setting to take effect.

New Arrow features
DataCAD supports the ability to draw curved leaders. Select “Arrows” from the “Text”
menu, toggle “Smart Arrows” on, and then pick the first point of the arrow. [F1]2PtArc and
[F2]3PtArc menu buttons appear. After selecting a second point, [F3]Tangent is available.
These buttons enable you to add curved segments to your leaders. You can toggle “At Tail”
on to draw arrows by selecting the tail end first, or toggle “At Head” on to draw them by
selecting the arrow head first. There is also a “1st Ortho” toggle, whose status is
remembered on a per-drawing basis. When enabled, the first segment of the leader line is
restricted to the ortho grid, even if Orthomode is turned off. The Snap Angle setting in the
Grids menu determines the number of divisions.
A new style of arrow head has also been added. Select “Symbol” from the “Style” submenu to select a symbol to act as the arrow head. When creating the symbol, you must
draw it pointing to the right, and define the insertion point at the tip of the arrow head. The
figure you draw must fit inside a square, as the square extents of the symbol are used when
calculating the position of the arrow head relative to the leader. The leader will stop at the
square extents of the symbol, so make sure to include any portion of the leader that would
be inside the square extents of the symbol. If you plan to use the arrow with Text Scale on,
draw the symbol at the real-world printed size. If you typically have Text Scale off, draw
the symbol scaled to the size at which it will be printed (for example, a 1/8” high printed
arrow at 1/4"=1’ would be drawn in a 6” square).
Since arrows support Text Scale and
the new Lock Size options in the Text
menu, you can create the custom arrow
head at the printed size. Toggle “Text
Scale” on to add the arrow head and
have DataCAD automatically scale it to
the current plot scale. Toggle “Lock
Size” on to keep the arrow head scaled
correctly even if you change your plot
scale.
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In addition, arrow heads have been enhanced so that when you stretch one end, the arrow
head rotates automatically to match the orientation of the leader line.
The Entity Properties Editor for Arrows has been enhanced to provide access to the Text
Size, Arrow Size, Arrow Aspect, Arrow Weight, Arrow Color, Lock Size and Arrow Style
settings.
When you change the Arrow Style from an open style (i.e. Open, Bridge or Tick) to a closed style (i.e.
Closed or Dot), clicking "Apply" will activate a "Filled" field with the options "Yes" and "No." Setting the
style to "Symbol" will prompt you to select a symbol. You may subsequently select a different symbol
by clicking the [...] button to the right of the Arrow Style field.

New options for changing Arrows have been added to the Change menu. Select
Change/Text/Arrows to access these options: Text Size, Style, Aspect, Weight, Color and
Lock Size status. Match is also supported.
Arrows may now be displayed outside the boundary of an active Clip Cube, similar to Text.
[Ctrl]+[right-click] on an arrow and mouse over "Clipping" to change the "Obeys Clip
Cubes" or "Ignores Clip Cubes" status.

Named Multi-View Windows
Multi-View Windows have support for custom names. These names are saved on a perdrawing basis, so they may be different from one drawing to another. Names of Multi-View
Windows may be saved in your default drawing file.

To turn Multi-View Windows on, open your drawing and choose "Toolbars" from the
"View" pull-down menu. Place a check mark next to each window that you would like to
display. Alternatively, you may open the drawing and press [Ctrl]+[w] on the keyboard to
turn on all Multi-View Windows.
Right click in a Multi-View Window to display the context menu and choose from the list of
available functions.
•

Selecting "View In" will read the current view of the drawing into the Multi-View
Window.

•

If the drawing contains any GoTo Views, a "GoTo View" sub-menu with a list of
available GoTo Views will appear. Selecting one of the views will read it into the
Multi-View Window. The Multi-View Window will automatically take the name
of the selected GoTo View.

After you have assigned a view to the Multi-View Window, you may rename it. Right click
in the Multi-View Window and choose "Rename." Type a new name for the window and
click OK.

Recent and Favorite Symbol browser folders
New options named "Recent Folders" and "Favorite Folders" have been added to the folder
icon pull-down menu of the Symbol Browser. As the names suggest, a list of recently
accessed symbol folders and favorite symbol folders will be displayed when you mouse
over these menu options. Click on "Add Current Folder to Favorites" in the Symbol
Browser’s “Options” menu to add the folder you are currently browsing to the favorites list.

The maximum number of recent and favorite folders to display is controlled by a
configuration setting in your Dcadwin.ini file:
[SymbolBrowser]
Max Recent=4
Max Favorites=4

View-dependent symbol layers
DataCAD has the ability to assign view dependency to layers inside symbols. A symbol
may contain layers which display information only in the 2D (plan) view, layers which
display information only in 3D (elevation, isometric, perspective and axonometric) views, or
layers which display information in both.

 To assign view dependency to layers inside symbols:
1. Save a symbol which contains all of the information which will display in both
2D views and in 3D views.
2. Right click on the symbol in the Symbol Browser and choose "Edit Symbol" to
launch the Symbol Editor.
If there is an instance of the symbol in the drawing, you could also [Ctrl] + [Right-click] on it
and choose “Edit Symbol” from the “Symbol Tools” menu, or you could double click on it.

3. Open the Symbol Layer Manager and highlight the layers which you want to
assign to 2D (plan) view projection only. Toggle the "Show in 2D" button on and
toggle the "Show in 3D" button off.
4. Now highlight the layers that you want to assign to 3D views (elevation,
isometric, perspective, axonometric). Toggle the "Show in 2D" button off and
toggle the "Show in 3D" button on.
5. If there are layers in the symbol that you want to display in both 2D and 3D
views, toggle both buttons on.
6. When you have finished assign view dependency to your layers, close the
Symbol Layer Manager by clicking “Close.”
7. Close the Symbol Editor by clicking the [x] in the upper left corner, and choose
"Yes" to save the changes.
Just like in DataCAD 12, the changes you make to the symbol in the Symbol Editor apply
only to the definition of the symbol in the current drawing. The original symbol on the hard
drive, and the definition of the symbol in other drawings, is not affected.
To save the symbol out to the folder on the hard drive, click the folder icon at the top of the
Symbol Browser and choose "Drawing" to browse symbols in the drawing. Locate the
updated symbol, right click on it and choose "Save As." Supply a name for the symbol and
select the folder in which to save it. You may overwrite the original version of the symbol.

DataCAD X3 includes a collection of over 1,000 2D/3D symbols, located in the
Symbols\sub-folder of the program installation folder.

View-dependency toggle
In conjunction with the support for view dependent layers within symbols, a drawing
setting has been created to define whether or not view dependency is used. Click the
"View" pull-down menu and choose "View Dependency" to turn this option on or off. When
on (checked), if layers within symbols have a 2D and/or 3D view dependency assigned,
DataCAD will display the proper layers based on the current view projection. When off
(un-checked), all layers inside symbols will be displayed regardless of the current view
projection.
Corresponding toolbar codes:
(V= in toolbar button, or 10XX# in keyboard macro)
1042 = View Dependency ON
1043 = View Dependency OFF

Scale-dependent symbol layers
Similar to the view dependent layers inside symbols, DataCAD X3 supports scale
dependent layers as well. This enables you to assign minimum and maximum scales at
which layers inside the symbols will be shown. If a layer falls outside the range of view
scales, then it is restricted from view. This gives you the ability to assign different levels of
detail to display at different scales. Scale dependency is recognized by both view scale (on
screen) and print scale (on paper).

For example, you could place hatching on a layer that is inside your symbol. Using the
Symbol Editor, assign a minimum scale of 1/16"=1' and a maximum scale of 1"=1'. When
you view a drawing which contains this symbol at a scale that falls in between the defined
range, the information on the hatching layer is shown, providing a greater level of detail.
When the current view scale for the drawing is outside the defined range, the information
on the hatching layer is not shown. This can help to reduce clutter when viewing your
drawing at small scales, or prevent unnecessary information from showing at large scales.
The method for assigning scale dependency to layers inside symbols is similar to the
method for assigning 2D and 3D view dependency.
 To assign scale dependency to layers inside a symbol:
1. Save the symbol which contains the information, separating the various levels of
detail by layer.
2. Right click on the symbol in the Symbol Browser and choose "Edit Symbol" to
launch the Symbol Editor.
If there is an instance of the symbol in the drawing, you could also [Ctrl]+[Right-click] on it
and choose “Edit Symbol” from the “Symbol Tools” menu, or you could double click on it.

3. Open the Symbol Layer Manager and highlight one or more of the layers that
you wish to assign to a scale or range of scales.
4. Click the "Minimum Scale" drop down menu and select the minimum scale at
which this layer will be shown.
5. Click the "Maximum Scale" drop down and choose the maximum scale at which
the layer will be shown.
If the same scale is selected for both minimum and maximum, the layer will only be displayed
when the exact scale is selected.

6. When you have finished assigning minimum and maximum scales to layers,
close the Layer Manager by clicking “Close.”
7. Close the Symbol Editor by clicking the [x] in the upper left corner, and choose
"Yes" to save the changes.
Before you can use this symbol in other drawings, you must browse symbols in the
drawing, right click on the edited symbol and choose "Save As" to save the new definition
out to the hard drive.

Scale independent text
A new "Lock Size" button has been added to the Text menu when “Text Scale” is active.
This setting will control the size of text such that it always prints at the absolute size you
define, regardless of the plot scale. Text which has this property assigned will change its
size automatically, each time you change the current plot scale. In the case of a MultiLayout Detail, the relative size of the text changes based on the scale of the detail, resulting
in printed text of the defined absolute size. For example, you could place a detail on a sheet
at 1/4" scale and have the text print 1/8” high. You could then place the same detail on a
different sheet at 3/8” scale, but the text will still print 1/8” high, without requiring you to
manually change the size of the text. DataCAD will do that automatically. Single line text,
ParaText, MText and Symbol Attribute text are all supported.
 Adding scale independent text to your drawing:
1) Toggle “Text Scale” on in the “Text” menu.
2) Toggle “Lock Size” on.
3) Click “Size” and define the size as the absolute height that you want the text to
appear on the printed page, for example 1/8” high.
4) Add your text to the drawing.
When you add the text to the drawing, DataCAD calculates the size relative to the current
plot scale (because Text Scale is on) and draws the text. For example, if your text is 1/8”
high, and your current plot scale it 1/8” = 1’, DataCAD will draw 1’ high text.
What makes “Lock Size” different is that the 1/8” height of the text is locked to the text
entity. If you change the plot scale to 1/16” = 1’, for example, DataCAD will automatically
change the height of the text to 2’. You can [Ctrl]+[Right-click] on a text entity and mouse
over “Lock Size” to change this property after you have added text to the drawing. You can
also use the Change/Text/Lock Size menu option to adjust this property for multiple text
entities using the standard selection menu.
There are new extended character codes that can turn Lock Size on and off in the Text menu:
(V= in toolbar button, or 10XX# in keyboard macro)
1048 = Lock Size ON
1049 = Lock Size OFF
When you change the current plot scale, any text which has Lock Size enabled will change
its size. As a result, the position of the text will also change. This change in position is
relative to the anchor point defined in the Text/Alignment menu, so you need to pay
attention to this setting when creating your text.
A minor change to the Text menu has also been added to automatically adjust the current
text size setting when you turn Text Scale on and off. If you go to the Text menu and Text
Scale is off with Size set to 6”, and the current plot scale is 1/4"=1’, when you turn Text Scale
on, DataCAD will automatically change the Size to 1/8”. It is no longer necessary for you to
set the size. Conversely, if you go to the Text menu and Text Scale is on, Size is set to 1/8”,
and the Plot Scale is 1/4" = 1’, when you turn Text Scale off, DataCAD will automatically set
the text Size to 6”.

When you export your drawing to DXF or DWG format, DataCAD automatically converts
the scaled text to the real-world size so that it looks the same.

Symbol Text Attribute enhancements
Symbol Text Attributes (SymAtr) support the same Clipping, Fix Text and Lock Size
properties that normal text supports. After adding the SymAtr entity to the drawing, use
the [Ctrl]+[right-click] context menu to adjust the settings for these attributes.
In the "Text" menu, toggle "Attribute" on. Place the text cursor in the drawing to open the
"Create Symbol Attribute" dialog. Enter the Attribute Name, Prompt and Value, and then
click OK. You may now [Ctrl]+[right-click] on the Symbol Attribute entity and choose from
the following new options:
Clipping > Obeys Clip Cube/Ignores Clip Cube
Fix Text > On/Off
Lock Size > Yes/No

Clipping
When "Obeys Clip Cube" is checked, portions of the Symbol Text Attribute which fall
outside the boundary of a Clip Cube will be restricted from view.
When "Ignores Clip Cube" is checked, the entire Symbol Attribute entity is always
displayed, even if it is partially or entirely outside the drawing’s Clip Cube boundary.

Fix Text
When "On" is checked text is automatically rotated to be right and bottom readable.
When "Off" is checked, text is not rotated.

Lock Size
When "Yes" is checked, Symbol Attribute text size is an absolute value as defined for printed
output, regardless of print scale.
When "No" is checked, Symbol Attribute text size is a relative value, and can be printed at
different sizes by changing the plot scale.

Lock Text Angle
Text inside symbols can be kept at a fixed angle. This
enables you to insert a symbol and define a rotation
angle, but keep the text inside the symbol displayed at
the angle at which it was originally created. You’ll find
the “Lock Angle” option in the “Ins Symbol” menu.
“Lock Text Angle” is also listed as an option in the
[Ctrl]+[right-click] context menu. This setting works for
regular text and Symbol Attribute text. Lock Angle and
Fix Text are mutually exclusive. Lock Angle may not be
used with Dynamic Flip.

Symbols with Lock Angle on, rotated
to different orientations

Lock Size on symbols
The Lock Size feature which automatically changes the size of text when you change the
plot scale can also be applied to symbols. It applies an enlargement factor to the symbol
which changes when you change your plot scale. The symbol insertion point acts as the
center of enlargement, so keep this in mind when saving the symbol and defining the
insertion point. The object you are drawing should be created at real-world size, since the
Lock Size feature takes care of adjusting the size of the object for the print scale
For example, let’s say you want to create a door tag symbol which prints a 1/8” high letter
inside a 1/4” high circle. First, you will draw the circle with a 1/4" diameter. Then, add the
text at 1/8” high, with the Alignment set to Center/Middle. Finally, when saving the
geometry as a symbol, select the center point of the circle as the insertion point for the
symbol. When you insert this symbol into a drawing with Lock Size enabled, and you later
change the plot scale, the symbol will enlarge about its center point, as will the text inside it.
When creating a symbol which contains text, do not enable Lock Size on the text which will be
included in the symbol. Since Lock Size is being applied to the symbol when you insert it, it is not
necessary to apply it to the individual objects inside the symbol.

Polygon Normal enhancements
There have been a number of enhancements that improve the handling or polygon normals.
In the 3D Polygon/Horizontal and Polygon/Rectangle menus, a “Normal Up” option has
been added. When this option is toggled on, the front face (normal) of the polygon is
oriented out of the screen, regardless of the order in which you select the points that define
the polygon. Previously, selecting points in a clockwise direction would orient the front
face into the screen away from the viewer, while selecting points in a counter-clockwise
fashion would orient the front face out of the screen toward the viewer.
In the 3D Polygon/Edit menu, a “Flip Normal” option has been added. After choosing this
command, you will select a polygon in the drawing. DataCAD will reverse the direction of
the polygon normal for the selected polygon. This operation supports the standard Entity,
Group, Area and Fence selection methods, including the ability to Mask.

New XREF Features
XREFs have been enhanced so that you can control the state of layers using GoTo Views in
the host drawing, and to automatically remove hidden lines from the current projection.

Link to Drawing GoTo Views
GoTo Views that are native to the host drawing can control which layers are turned on and
off inside of XREFs. This setting operates on a per-drawing basis. Click the “Insert” pulldown menu, mouse over “Reference File Management” and click “Remember Layer
Settings for GoTo Views” to enable this option.
When you save a GoTo View in the host drawing, DataCAD will also include the on/off
status of layers inside any XREFs which are present. When you recall the GoTo View,
DataCAD recalls not only the drawing layers, but the layers in the XREFs as well.
The status and position of an XClip is not remembered with the GoTo View parameters.

Remove hidden lines in XREFs
An option named “Hide” has been added to the [Ctrl] + [right-click]/XREF Tools context
menu. When you select this option, DataCAD will perform the Hidden Line Removal
operation on the selected XREF, and store the result as a symbol. DataCAD automatically
replaces the XREF instance with the symbol instance. The hidden line image inside the
symbol is flat on the ground plane, but the symbol is then inserted in the current view
projection. The result is a hidden line image of the XREF in the current view.
If you make changes to the model, you can [Ctrl]+[right-click] on the symbol and choose
“Update Hide” to update the hidden line result with the changes you made. You can also
choose “Unhide” to revert back to a wireframe representation of the model.

Merge clipping boundaries
XREF Clip Cubes (XClips) and Symbol Clip Cubes (SClips) may now be merged with the
parent XClips. You will find this option both in the “Reference File Manager,” and in the
“Reference File Management” sub-menu of the “Insert” pull-down menu.
When this option is unchecked, DataCAD X3 will treat XClips that are applied to nestedlevel XREFs and SClips applied to symbols within the XREF as separate clipping
boundaries. This works the way it did in DataCAD 12. The information inside the XREFlevel XClip, the information inside the nested-level XClip, and the information inside SClips
will all be displayed.
When this option is checked, the nested level clipping boundaries are ignored. If you apply
an XClip boundary to the top-level XREF, only the information inside the boundary is
shown, even if the XREF contains a nested XREF or symbols with SClips.

New GoTo View features
GoTo Views have an optional link to any Multi-Layout Details that were created from them,
and can also have their hidden lines removed from the current view.

Linking GoTo Views with Multi-Layout Details
If you use GoTo Views to define your Multi-Layout Details, you can link your details to
your views. When you adjust which layers are included in a GoTo View, either by turning
existing layers on and off or by adding new layers or deleting existing ones, and then use
the “Update” option in the GoTo View menu to update the saved view parameters, the
linked Multi-Layout Detail updates automatically. You no longer have to use the “Layer
Toggle” command in the Multi-Layout/Details menu to adjust which layers are included in
the detail. Whether or not GoTo Views are linked to Multi-Layout Details is remembered on
a per-drawing basis.
 To link GoTo Views with Multi-Layout Details:
1) Choose “Multi-Layout” from the “Print/Plot” menu.
2) Pick “GoTo View” from the “Multi-Layout” menu.
3) Toggle [S8] Linked on.

When “Linked” is on, each Multi-Layout Detail in the drawing is linked to the GoTo View that was used
to create it. This is a global drawing setting, and cannot be used selectively on just one or some
details. Turning “Linked” off will enable you to update GoTo View parameters without affecting
existing Multi-Layout Details.

When you place a Multi-Layout Detail that is linked to a GoTo View, the default detail name
has the same name as the GoTo View. Press [Enter] on the keyboard to accept this default
name, or type a new name and press [Enter] to proceed. In addition, if you rename the
parent GoTo View, DataCAD will automatically rename the linked Detail. The names of
linked Details are displayed in green text on the menu buttons, instead of the standard black
text.

Remove hidden lines in GoTo Views
Using the “Hide GTV” button in the 3D Hide menu, you can select any GoTo View in your
drawing and DataCAD will perform the hidden line removal process on it. A “Hide All”
option is also available to perform the operation on all GoTo Views in the drawing.
The time it takes to perform the operation can be lengthy, so you should only use the Hide All method
if there are only a few GoTo Views, or if you are prepared to wait. The [End] key on the keyboard will
skip the current view, and the [Del] key will abort the command.

The result of the hidden line removal operation is saved as a symbol in the current drawing.
During this process, the Symbol Browser automatically changes its current view to browse
the symbols in the drawing. You may then place instances of the symbols in your drawing.
They work just like normal symbols, and may be edited further in the Symbol Editor.
The Hide GTV procedure uses all of the same settings that can be adjusted in the Hide
menu. You can use “HLR Partial” to speed up the process, “Pierce” to calculate
intersections between surfaces and edges, and “Clip Cube” to recognize the status and
position of the Clip Cube. This option is very helpful because the Clip Cube is one of the
parameters that are remembered with the GoTo View definition. In addition, the settings in
the Hide/Options menu are also recognized by this feature.
If you make changes to the model, you can update the hidden line symbol. The “Update
Hide” option is available in the [Ctrl]+[right-click]/Symbol Tools context menu, or by rightclicking on the symbol in the Symbol Browser. Keep in mind that if you used the Symbol
Editor to make changes to the information inside the symbol, those changes will be
overwritten by the Update Hide process.

Polyline enhancements
Polyline entities, created via the 2D Curves menu, may be rotated off the ground plane. You
can use the 3D Rotate command to rotate them about the X or Y axis, resulting in an inclined
polyline. You can also create them in any parallel view projection. Using polylines in this
manner enables you to create complex 3D shapes which contain curved edges and voids.
The Entity Properties Editor for polylines has a “Height” field which defines the unit height
of the polyline entity. This value represents the perpendicular distance from the bottom
face to the top face, in the polyline’s construction plane.

When you use the Identify command on a polyline, the “Z-Min” and “Z-Max” values
returned on the “Attention” toolbar define the lowest and highest points of the polyline.
The “Unit Height” value shown on the “Coordinates/Hints” toolbar is the difference
between the lowest and highest points.
A “Push Pull” option has been added to the Curves/Polyline/Edit menu. This command
enables you to dynamically stretch the top or bottom of a polyline.

Sun Shadow Studies
A new, OpenGL-based Sun Shadow rendering window provides you with sun angle and
shadow data based on date, time, and location. A three-dimensional representation of the
path of the sun across the sky from sunrise to sunset can also be displayed around your
model for illustrative purposes. You can save individual views out to various image
formats or combine them into a time-lapse animation. Click the “Display model in Sun
Shader” button on the “Rendering” toolbar, or choose “Sun Shader” from the “View” pulldown menu to open the Sun Shadow rendering window.

Navigation
Positioning your model in the Sun Shader window is similar to using the o2c-based 3D
Object Viewer. Click your left mouse button and drag the mouse to spin the model around.
You can use the scroll wheel on your mouse or click and hold the right mouse button to
zoom in and out. Pressing [Shift] + [Left button] will pan the model.

Options dialog
The options dialog, accessed via the “Sun Shader Options” toolbar icon or the “File” pulldown menu, contains the configuration settings for the Sun Shader.

Shadow Study section
The Shadow Study section of the Options dialog contains settings that define the location of
the model, and the relative position of the Sun.

Location tab

The Shadow Study Settings section contains tabs that enable you to select the location of
your site, the date and time or range of time, and adjust the properties of the shadows that
are cast.
On the "Location" tab, select a Country from the drop-down list and then select a City. If the
city you wish to use is not shown, click the globe icon to the right of the "Country" dropdown to access the "Manage Locations" dialog. In "Manage Locations," click the [+] icon to
add a new location. Choose a country from the "Location" drop-down, or just type a name.
Choose the City from the drop-down to the right of the Country, or just type a name. You
may then proceed with defining the longitude and latitude of the location.
Longitude is an angular measurement ranging from 0° at the Prime Meridian to 180°
Eastward (+) and 180° Westward (-). Each degree of longitude is sub-divided into 60
minutes, each of which divided into 60 seconds. Latitude is an angular measurement
ranging from 0° at the Equator to 90° at the poles, with North being (+) and South being (-).
Each degree of latitude is sub-divided into 60 minutes, each of which divided into 60
seconds. Longitude and latitude of locations around the world are available on the Internet.
Decimal expressions of longitude and latitude are not currently supported, so if the
information you find is noted in decimal form, you will need to convert it to degrees,
minutes and seconds.
Date and Time tab

In the "Date" field, click the drop-down menu to select a specific date from the list. You can
click the Calendar icon to the right of this field to set the value to today's date, based on
your Windows system settings. Select the radio button marked "Specific Time" to set the
exact time of day for the shadow, or click the clock icon to use the current time.
Alternatively, you can select the radio button marked "Frequency" to play an animation
which shows the path of the shadows from sunrise to sunset at the selected time frequency.
If Daylight Saving Time is in effect, click the check box and define the value in hours.
Shadows tab

You can define the "Minimum altitude to cast shadows" by entering a value into the field.
The default is 5. When the Sun position is lower than the defined altitude, shadows are not
cast on the model. When “Cast Shadows” is checked, you are working in Shadow Study
mode, and shadows will be displayed in the model.
Check the box next to "Display Sun trajectory" to include lines which show the position of
the Sun relative to the model. You may also define the radius of the symbolic Sun, and the
distance from the model to the symbolic Sun. If a specific time is selected on the "Date and
Time" tab, the line represents the Sun trajectory at the selected time. If a frequency is
selected, there are three lines which show Sunrise, Solar Noon, and Sunset.
The “Animation Speed” section determines the speed at which the Sun Shader cycles
through the animation of the Sun path, in milliseconds, when you press “Play.” Pressing
“Fast Forward” doubles the speed, and pressing “Fast Fast Forward” triples it.
In the “North” section, you may decide whether or not to display a compass graphic on the
ground plane, and whether or not to use DataCAD’s “North” angle. If you do not use
DataCAD’s North angle, you may define a specific angle to use for North.

The "Rendering" section enables you to define a color for the "Shadow tint" by clicking the
color selection button. Alternatively, you can pick "Shadow contrast" and use the slider bar
to define the level of contrast to use when displaying the shadows.

Lighting section
The "Sunlight" must be enabled in order to display shadows in your model. This light is
positioned based on the real-world position of the sun relative to the location that you
define on the "Shadow Study" section of the Sun Shader Options dialog. It produces
shadows that correspond to the real shadows you would see on the site. Set the intensity
using the slider bar or the input field. The default value is 80.
The "Key Light" does not cast shadows, but may be used to illuminate the dark side of the
model while using the Sunlight to show the path of shadows. Use the radio buttons around
the globe icon to define the position of the Key Light relative to the model. Set the intensity
using the slider bar or the input field. The default value is 80.
"Ambient Light" is used for general illumination of the model. The "Headlight" adds
another level of ambient lighting to the model. Set their intensity using the slider bar or the
input field. The default values are 20.
The "Custom Lights" section adds up to five positional light sources. These correspond to
the lights in DataCAD's "Shader" menu. Any changes you make to the settings in this
section will affect the same lights in the drawing, and vice versa. In terms of defining the
position of these lights, you are limited to setting the X, Y and Z coordinates while working
in the Sun Shader, so you may find it easier to set the positions using the options available
in DataCAD's Shader menu. Use the "Color" column to set the intensity (white is highest,
black is lowest).

Ground Plane section
In the "Ground Plane Settings" section, place a check in the box marked "Display ground
plane" to add a polygon which represents the ground plane in the model. If your model
does not include a ground plane or other ground surface, this option is necessary in order to
have a surface on which to display shadows. Without it, shadows will only display on other
portions of the model.
The "Scale" section includes a "Factor" setting which describes the size of the ground plane.
The value is a multiple of the extents of the model. The "Elevation" section indicates the
position of the ground plane in the model. When "At base of model" is checked, the ground
plane is situated at the lowest calculated point of the model extents. When un-checked, you
may enter a value into the "Height" field which represents a real-world Z-location of the
ground plane.
The "Material" section provides the ability to map a DataCAD rendering material to the
ground plane, giving you the option of showing grass, for example. To remove a previously
set material, highlight the value in the field and press [Del] on your keyboard to delete the
information.

Background section
You may select from three different background types, a gradient, a solid color, or an image.
In the "Background Settings" section, choose the radio button labeled “Gradient” to define a
gradient background. You will then define a “Top Color” and “Bottom Color” using the
color squares to the right. Alternatively, you may select "Background color" to set a solid
color for the background. Click the "Set background color" button to the right and then
select a color from the palette and click OK. Finally, you may choose the "Background
image" radio button to define an image for the background. Click the "Set background
image" button to the right to choose an image from your hard drive. To remove the selected
background image, highlight the value in the field below and press [Del] on your keyboard
to delete it.

Performance section
The "Rendering method during Pan/Zoom/Rotate" may be set to "Render as wireframe,"
"Render with entity colors" or "Render with materials." The value for this setting is
remembered on a per-drawing basis. Performance varies from one computer to another,
based on processor type and speed, available memory, and graphics card, so you may want
to try different settings to see which works best for you.

Shadow Study Results
After you have configured the location and time for the Shadow Study Settings, you can
click the "Shadow Study Results" toolbar icon to review the data. It includes the Altitude
and Azimuth of the Sun, and the apparent or true time for Sunrise, Sunset and Solar Noon.
If you have selected the option to show a frequency of shadows, you may click the "Play"
toolbar icon to review an animation which shows the path of the Sun and the resultant
shadows on the model. You can alternatively click the slider bar to select various times of
day, or select a specific time from the drop-down menu, and the Sun Shader will display the
Sun position and resultant shadows in your model.
Other toolbar icons enable you to select from pre-defined view projections, including
perspective, isometric, plan, or various elevation views. When Shadow Study mode is
enabled, you can render the model with shaded faces or with shaded faces and edges.
When Shadow Study mode is disabled, wireframe and hidden line modes are also
supported.
Click the "Save Image" icon, or select "Save Image" from the "File" menu to save out an
image from the Sun Shader window. You may specify a resolution that is higher than your
screen resolution, limited only by your graphics hardware.

3D Object Viewer Enhancements
The 3D Object Viewer interface has had a number of toolbars added to improve ease of
navigation. In addition, the 3D Object Viewer supports saved views, similar to GoTo Views
in DataCAD.

Saved Views
Saving a view in the 3D Object Viewer is similar to saving a GoTo View in DataCAD. After
you save a view, you may recall it at a later time. Parameters saved with views include
View Name, Eye Point (X, Y, Z), Focal Point (X, Y, Z), Cone Angle, Parallel or Perspective
Projection, Zoom Factor, View Rotation about X-Axis (screen), View Rotation about Z-Axis
(world), Background Mode (Color only, Single image, Tiled image), Background Color,
Background image, Background Picture Offset (X, Y), Lights (1, 2, 3, and User-defined:
On/Off), Walk-through Mode (On/Off), and Anti-aliasing (On/Off).
 To save a view in the 3D Object Viewer:
1) Make sure the “Views” toolbar is displayed. If it is not, select it from the
View/Toolbars pull-down menu.
2) Position your model in the viewer, adjusting any of the parameters named above
as desired.
3) Click the “Add View” button on the Views toolbar.
4) Supply a name for the view, up to 80 characters.
The view name is now available to recall from the drop-down list. All of the parameters
named above are saved to the view definition.
Saved views may also be updated after they have been created.
 To update view parameters:
1) Select the saved view that you wish to update from the list.
2) Adjust the view parameters as desired.
3) Click the “Update View” button on the Views toolbar.
4) Click “OK” to confirm that you wish to update the view parameters.
DataCAD updates the view parameters.
If you no longer wish to store a saved view in the drawing, you may delete it from the list.
 To delete a saved view:
1) Select the view you wish to delete from the list.
2) Click the “Delete View” button on the Views toolbar.
3) Click “OK” to confirm that you wish to delete the view.
DataCAD deletes the saved view.

New Toolbars

The interface of the 3D Object Viewer has been updated to include new toolbars. You may
turn them on and off by selecting them from the View/Toolbars menu. Options for “All
On” and “All Off” are available, along with a “Lock Toolbars” option to keep them in place
once you have configured the interface.
The following toolbars are included:
Display Mode, Lights, Pan, Message, Parallel Views, Rotate, Rotate X (slider bar), Rotate Z
(slider bar), View Stats: Eye/Focal Point, View Stats: Cone Angle Zoom, View Stats: X/Y
Pan, View Stats: X/Z Rotation, Views and Walkthrough.

Fixed Distance
There is a new “Fixed Distance” option in the “View” pull-down menu. When off (default),
increasing or decreasing the field of view will result in a change to the distance between the
eye and focal points. When on, the distance between the eye and focal points remains fixed,
causing the increase/decrease field of view buttons to operate more like a zoom lens on a
camera.

Limit Rotation Angles
If this option is checked in the “View” pull-down menu, the rotation of the model in the 3D
Object Viewer is limited to 360° in any axis.

Copy, Copy (Raytrace) and Copy HTML
These options are available in the right-click context menu which appears in the 3D Object
Viewer. When you select Copy, the Object Viewer copies the current image to the
Clipboard. You may then paste it into a paint program, or any other application that
supports pasting images. The Copy (Raytrace) option performs the same function, except
that the result is raytraced to include shadows from light sources. The Copy HTML option
will copy HTML code required to display the object on a Web site to the Clipboard. You
may then paste it into an HTML editor while creating a Web page.

Miscellaneous Enhancements
Save As previous version
Although DataCAD X3 files use the same *.AEC file extension as DataCAD 11 and
DataCAD 12, internally the file format is different. In order to work with users of previous
versions, you will need to use the “Save As” command in the “File” menu to save your file
back to an earlier format. If your associate is using DataCAD 12, set the “Save As Type” to
“DataCAD 12 Files.” Similarly, if your associate is using DataCAD 11, set the Save As Type
to “DataCAD 11 Files.”
When saving back to DataCAD 11 or DataCAD 12 format, the file is automatically renamed.
As an example, a file named “Example.aec” in DataCAD X3 will become “Example.d11.aec”
when saved to DataCAD 11 format, or “Example.d12.aec” when saved to DataCAD 12
format.
What happens when you save your file back to an older format?

Since DataCAD X3 has new features that previous versions did not have, saving back to
DataCAD 11 or DataCAD 12 format will change some of the data in your file. Smart arrows
are exploded to groups of lines. Any text which has Lock Size enabled has its scaled size
converted to the real-world size, so that it does not look different on the screen. MText gets
exploded to multiple, single line text entities.

Smart Entities
The Change/Match/More menu now has the ability to match a Smart entity’s type. After
you choose Change/Match and click “More…,” select “Smart Type.” Right click to return
to the Change menu, and then select the object(s) to change. When prompted, select the
Smart entity whose type you wish to match.
A "Creation Method" field has been added to the Entity Properties Editor for Smart doors
and windows. It shows whether the Smart door or window was created "By Sides" or "By
Center." You may click this drop-down field to change the setting for the selected Smart
door or window. In effect, it changes the anchor point of the opening. If you change the
size of the opening in the type definition, DataCAD resizes the opening relative to the
anchor point.
You may turn off the display of node markers, which appear as an x at each end of a Smart
wall and as a diamond at each side of a Smart door or window, via the “Node Markers”
toggle button in the “Architect” menu. Although node markers never print, turning off
their display can reduce screen clutter when zoomed out.

SketchUp 8 support
DataCAD X3 supports the ability to insert and XREF SketchUp version 8 files. Files are still
exported to SketchUp version 6 format, to preserve compatibility with older versions.
Newer versions of SketchUp have the ability to open older format files, however older
version may not open newer files.

Measures
The Measure\PntToPnt and Measure\Line commands now return Length, Run, Rise and
Angle measurements, all of which can be added To Drawing. The values are shown on the
“Attention” toolbar portion of the interface.

Smart Walls may now be selected when using "Line" and "Line Angle" in the “Measures”
menu.

Dimensions
DataCAD X3 has toolbar codes that you can use to set the On/Off status of dimension
witness lines:
(V= in toolbar, or 10XX# in keyboard macro)
1044 : Suppress witness line 1 = TRUE
1045 : Suppress witness line 1 = FALSE
1046 : Suppress witness line 2 = TRUE
1047 : Suppress witness line 2 = FALSE
DataCAD no longer exits "Entity" mode in the Dimension/Linear menu until you right-click
or choose "Exit." Previously, it would return to the Linear menu after you selected the entity
to dimension and then placed the dimension in the drawing.
There is a key in the configuration setting file, Dcadwin.ini, that will omit the leading zero
from associative dimensions of less than one meter when working in metric scale type:
[General]
Meters Show Leading Zero=TRUE
Set this to FALSE to remove the leading zero. For example, when set to FALSE, a dimension of
0.65m would become .65m instead.
Smart walls, doors and windows are supported by "AutoDim" mode in the
Dimension/Linear menu. After turning “AutoDim” on, simply draw a line which crosses
through the nodes of the Smart walls, doors and windows you wish to dimension, and then
choose the side on which to draw the dimensions. DataCAD automatically adds the
dimensions to the drawing. There is also an option in the AutoStyle menu to include Smart
door and window jambs in the dimensions.
Dimensions may be displayed outside of the boundary of a Clip Cube, similar to text and
Smart arrows. To enable this feature, [Ctrl]+[Right-click] on an associative dimension and
choose “Ignores Clip Cube” under “Clipping.” You may also use the Change/More/Clip
Cube menu option to change multiple entities at once.

DXF and DWG files
DataCAD X3 supports the ability to import and export AutoCAD DXF and DWG files up to
release 2010-2011 format.

When importing a DXF or DWG, the manner in which the "Move drawing to origin” setting
on the “DWG Import Entity Assignments” dialog works has been updated to provide more
accurate results. It calculates the center of the extents of the entities in the drawing, and sets
that point at absolute zero. You should only use this setting if you know that all of the data
in the DXF or DWG file you are importing is far away from absolute zero. This function
cannot selectively move some of the information closer to the origin, so if the data in the file
is spread over a large expanse of space in the original file, it will remain that way after
import. You will need to use the “Move” command to move the portion of the drawing that
is far away closer to the rest of the information.

Entity Properties Editor
New options to alter the "Scale" and "Rotation" of symbols, XREFs and quadrics have been
added to the Entity Properties Editor. When you [Ctrl] + [right-click] the entity and choose
“Properties,” you can see the current settings and make adjustments if needed.

The ability to change the Scale and Rotation angle of symbols, XREFs and quadrics has also
been added to the Change menu. Choose “More…” and then pick which setting to change.
A “GoTo View Hyperlink” field has been added to the Entity Properties Editor. If a GoTo
View is hyperlinked to the selected entity, it will display here. You may also use the dropdown list and then choose a GoTo View from the drawing to link to the selected entity.

Enlarge
There is a new "By Points" option under "CalDist" in the "Enlarge/Enlargement" menu.
When this option is toggled on, you click two points to define the known distance, and then
click two more points to define the new distance. DataCAD uses this information to
automatically calculate the enlargement factor.

Symbols
Symbols may now be displayed outside of the boundary of a Clip Cube, similar to text and
Smart arrows. To enable this feature, [Ctrl]+[Right-click] on a symbol and choose “Ignores
Clip Cube” under “Clipping.” You may also use the Change/More/Clip Cube menu option
to change multiple entities at once.
When "Symbol Scale" is on in the "Ins Symbol" menu, a trap door to the "Plot Scale" menu is
available. This enables you to change the current plot scale without having to first exit
symbol insertion mode. Symbol Scale automatically sets the symbol enlargement factor
based on the current plot scale.
The "By Center" option in the "Ins Symbol" menu enables you to insert symbols by the
center of their extents, excluding the insertion point.
There is a new "DelEnts" option in the Save Symbol menu. This setting, remembered on a
per-drawing basis, is on by default. When turned off, the entities that you select to be saved
into a symbol are no longer deleted from the current drawing.
A "Save As" option has been added to the Symbol Tools context menu. You can
[Ctrl]+[Right-click] on a symbol in the drawing, mouse over "Symbol Tools" and then select
"Save As" to save a copy of the symbol to a folder on the hard drive.

Object Snapping
"Nearest" object snapping will now work on 3D entities.

Clipboard
DataCAD X3 can automatically save information from the Windows Clipboard to a symbol
in the drawing. After copying data to the Clipboard, choose "Paste as Symbol" from the
"Edit" pull-down menu. The symbol insertion point is automatically set to absolute zero, so
you will generally use the “By Center” option in the Paste menu. The symbol definition is
only present in the current drawing, so if you wish to add it to your symbol library, click the
folder icon on the Symbol Browser and choose “Drawing.” Locate the new symbol, rightclick on it and choose “Save As.” Supply a name and select a folder in which to save it.
Alternatively, you could use the new [Ctrl]+[Right-click]/Symbol Tools/Save As command
to select the symbol from the drawing area.

The "Clipboard Select" command has a "By Center" option that is available when "Ins Point"
is toggled on. It will automatically calculate the center of the extents of the selected entities
when you copy the information to the Clipboard. If you later use the Edit/Paste As Symbol
function, the symbol insertion point will be set to the center of the extents of the entities,
rather than absolute zero.

Printing and Plotting
There is a new “Extents” button in the Multi-Layout/Layout menu when creating a multiscale plot sheet. While in layout mode, toggle this button off to see the actual drawing
information in the detail, rather than the extents box you typically see by default. This
option improves accuracy when placing your detail on a sheet.
A new Plot Scale stamp has been added to the Insert/Stamp menu. The token for this stamp
is @PLOTSCALE. The Plot Scale stamp will update automatically to show the current plot
scale, so if you change the scale after inserting the stamp, it will change to show the new
scale. When you place a Multi Scale Plot detail which contains the stamp, it will show the
selected plot scale for the detail. In addition, the Insert/Stamp function now supports the
ability to use Text Scale to define the size of text relative to the plot scale, and Lock Size to
lock the size of the text to the real-world printed size.
You may customize the stamp by editing the [Stamp] section of your Dcadwin.ini file:
[Stamp]
PLOTSCALE_1MenuText=Plot Scale 1
PLOTSCALE_1=Scale: @PLOTSCALE = 1'-0"
PLOTSCALE_2MenuText=Plot Scale 2
PLOTSCALE_2=This is the current plot scale: @PLOTSCALE

Settings
You may now Load, Edit and Save the "Decimals" file, Dcadwin.dec, via the
Utility/Settings/EditDefs menu.

Texture Origin
The View/Rendering/Texture Origin pull-down menu has options that enable you to
“Show” and “Clear” the texture origin of entities in your drawing.
There is also an extended character code for Set Texture Origin:
(V= in toolbar button, or 10XX# in keyboard macro)
1052 = Set Texture Origin

Other New Extended Character Codes
(V= in toolbar button, or 10XX# in keyboard macro)
1050 = Orthmode On
1051 = Orthmode Off

Move/To Layer and Copy/To Layer
There is a “Layer Color” toggle in the Move/To Layer and Copy/To Layer menus. This
option appears after you select the destination layer. When enabled, the selected entities
will inherit the color currently assigned to the destination layer.

Curves
Beziers and B-spline curves, in the 2D “Curves” menu, may now have up to 20 control
points. The previous limit was 8. In addition, you may define different Z-Base and ZHeight values for Beziers and B-spline curves.

